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40. Sim Module - Common Tools
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40.1.

40.1.1.

40.1.2.

Drawing flowsheets and adding tables to flowsheets

This chapter explains how to draw and add tables to a flowsheet. In addition to the
instructions chapter, the user should also read unit-specific Chapters 41-47 of this manual
before running the simulations (41- 42 Distribution Units, 43-44 Reactions Units, 45-46
Minerals Processing Units and 47 Converter Units, which are needed if different units are
combined in the flowsheet).

The most important icons for drawing are:

bl O] (R B

Fig. 1. Icons for drawing Units and Streams, where the first icon is Select, U = Generic Units, R =
Reactions Units, D = Distributions Units, and the last icon is Streams.

Drawing units

Select the unit by left-clicking the unit icon. The cursor shows the user which icon is active.
Move the cursor to somewhere on the flowsheet and draw a unit by a) holding down the left
mouse button b) moving the mouse to increase the size of the unit c¢) releasing the button to
stop drawing, see Fig. 2. The user can change the size of the units later.
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Fig. 2. Drawing two Reactions (Hydro) units. The Reactions unit is the active icon in this figure, see
the mouse cursor.

Drawing streams

Select the stream icon with the mouse (left button). Move the cursor to somewhere on the
flowsheet and click the mouse (left button) to start the stream. The user can add a corner to
the stream with another click and double-click (left button) to end the drawing of the stream,
see Fig. 3.

Editing Streams

How to a) make a corner on the stream b) change the angle of the stream and c) remove
the corners of the stream d) change the input and output units of the stream e) check the
connection of the streams.
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a) Choose the Select icon and by holding down the shift + left mouse button, the
user can make corners on the streams by moving the mouse.

b) Choose the Select icon and click the stream to see the nodes (blue squares).
Hold down the mouse button on a node and move the mouse to change the
angle of the stream.

) Choose the Select icon, select the stream, then select one stream node (blue
square), move one node on top of another node to remove a stream corner.

d) Choose the Select icon and move the beginning or end of the stream to a new
unit or out of the unit. HSC8 Sim will suggest a new connection to the stream
that the user can accept (OK) or Cancel.

e) When the flowsheet is ready, check that the streams are connected to the
correct units. The user can check connections visually, see Fig. 4. A white circle
or arrow means that the stream source or destination is unknown (a gray arrow
means it is known). Blue stream means input, black stream is between two units
and red stream means output. It is also possible to click the Tools menu to
show the process tree. The most time-consuming task is selecting streams one
by one and looking at the properties (process sheet) to see the source and
destination of the stream.
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Fig. 3. Drawing streams.
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Fig. 4. Visualizing stream connections.
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40.1.3. Renaming units and streams

Choose the Select icon and rename units and streams by double-clicking the name or click
the name label and edit properties (process sheet) - NamelD cell, see Fig. 5.
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Fig. 5. Renaming units and streams.
40.1.4. Inserting tables and stream tables (typically done after simulations)

The user can add tables to visualize important parameters of the results. Choose the Table
icon and draw the table in the same way as you draw the units. The user can open table
editor by double-clicking the table, where the user can add more rows and columns. It is
important to uncheck Size lock when adjusting the table size. It is typical to use this table to
show a summary of the results. The user can insert header labels and add any process
values as cell references in this table (copy cell reference from the unit sheets and paste
cell reference in the table), see Fig. 6 and Fig. 7.

The user can also insert stream tables by clicking the Stream Table Editor icon, which will
open the editor where the user can add variables (by double-clicking). A visible variable list
can be sorted by dragging the variables up and down in the list, see Fig. 8. The user can
check which stream tables can be visible or invisible in the editor or does that later from
View Menu...stream tables...show/hide all.
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Fig. 6. Table added to the flowsheet.
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Fig. 7. Table editor, remember to uncheck Size lock when inserting rows and columns.

! ﬁ Stream Table Editor

\Available variables:

\;ﬁs-'.i-ble \rariébies:

| Amount Phase 2 (t/h)
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Gas Phase {t/h)
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Fig. 8. Stream tables editor for adding stream tables to the flowsheet. Add and remove variables by

double-clicking.
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40.1.5. Editing a flowsheet

Sometimes the user wants to edit a flowsheet later and add new units. Adding a new unit
(Unit 3) in the middle of a stream (Stream 1) connected to two units (Unit 1 and Unit 2) is
explained here. First, draw a new unit (Unit 3) and connect Stream 1 from Unit 1 to Unit 3.
Then add a new stream (Stream 2), which starts from Unit 3 and ends at Unit 2, see Fig. 9 -
Fig. 11. Information in Unit 1 and Unit 2 is automatically updated so the user only needs to
make changes in Unit 3 and Stream 3 to run the simulation.
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Fig. 9. Adding a unit to a stream between two units, starting situation.
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Fig. 10. Adding a unit to a stream between two units, add new unit and change stream connection.
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Fig. 11. Adding a unit to a stream between two units, final situation.
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40.2.

Menus in the flowsheet window

In this section, the Sim flowsheet menus (File, View, Select, Tools, Drawing Tools, Window
and Help) are introduced.

File menu

This menu is similar to many other programs where the user can (see also Fig. 12):

1.  Start New Process...which opens an empty flowsheet.
2. Open Process...which is a *.Sim8 (HSC8) or *.fls file (HSC7 flowsheet).
3.  Save Process...quick save process (overwrites previous version)
4.  Save Process as...save process with the file name and location given by the user
5.  Save Backup...process should be saved first before a backup can be made. It is
recommended to save a backup from time to time during the simulation.
6. Backups...If the user has saved backups, they can be managed (checked, restored,
deleted) here.
7. Recent Processes...shows the 10 most recent simulations made by the user
8. Export Flowsheet Image...The user can export the flowsheet as an image (png, vdx,
pdf, svg, dxf) or copy a flowsheet picture to the clipboard to use it in reports and
presentations.
9. Print flowsheet...prints the flowsheet
10. Exit HSC Sim...will close the Sim program
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Fig. 12. File menu.
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View menu
In the View menu the user can (see also Fig. 14):

1. View and edit Flowsheet settings, where the user can change or restore default
settings of the flowsheet. Exit saves the settings and leaves this editor, see Fig. 13.

@ Flowsheet Settings x

General A -
Marker Size (pt) 2.5
Marker Colar [ 70; 130; 180
Link Hit Distance {pt) 2
Flowsheet Background Color [ 255; 255; 255
Auto Resize AllDirections
Persist Tool True

Grid A
Grid Style Points
Show Grid True
Grid Color [ 176; 196; 222
Grid Width 2
Grid Height 2
Snap To Grid True
Auto Align Nodes False

Header Label A
Font Name Arial
Font size 16
Font Bold False
Font Italic False
Font Color N 0; 0; 0

Default Unit Settings : Label ~
Font Name Arial
Font size B8
Font Bold False
Font Italic False
Font Color I 0; 0; 0

General
Save Save As ... Load gLnad Fi Restore Default Exit

Fig. 13. Flowsheet settings.
2. Show and hide the flowsheet Name labels, Value labels and Stream tables.
3.  Check and uncheck all Toolbars, which are explained in section 40.3.
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Fig. 14. View menu.
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The Select menu is typically used to edit or move many properties at once. Here the user
can: (see Fig. 15 below)

© e N ODdRE

[ S
N PO

13.

Bl nsc sim 8
File View | Select | Tools
(=

Main F

)

R
O

¥

E

¥

Select all Units on the flowsheet.
Select all Unit Name Labels on the flowsheet.
Select all Streams on the flowsheet
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Select all Stream Tables on the flowsheet.

Select all (unit and stream) Name Labels on the flowsheet.
Select all (unit and stream) Value Labels on the flowsheet.

Select all Other Text Labels on the flowsheet.
Select All Labels on the flowsheet.
Select all (not including stream tables) Tables on the flowsheet.
Select all Other Drawing Objects on the flowsheet.
Select All Items on the flowsheet.
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Fig. 15. Select menu.
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Tools menu

The Tools menu includes many advanced options that may be needed in flowsheet
simulation. The user needs detailed instructions on how to use those tools. Some tools are
explained here and others in different Chapters, see the list below. The Tools menu
includes (see Fig. 17):

1. Process information

% Process Information — |l o | x

Process

Process Mame: |
Technology:

General Comment:

Location

Location: -
Location Comment:

Developer

Author:
Date: 26.9.2014 hd

Version Number:
Cancel oK

Fig. 16. The user can add Process Information to this sheet.

LCA Evaluation (see Chapter 49)

Mass Balancing (see Chapters 51 and 52)

Reports (see section 40.2.1)

Select Unit Models (see section 40.2.2)

Scenario Editor (see section 40.2.3)

Show the process tree (see section 40.2.4)

Errors in flowsheet (shows possible errors in the flowsheet)
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Fig. 17. Tools menu options.
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40.2.1. Reports

A summary of flowsheet results can be saved and printed here. There are two pages in this
report sheet: one for units and one for streams. This report uses Hydro_example3.Sim8.

EX Flowsheet report = JLo J[x
P T =
e o R
Save Print Add custom Cells
sheet
A B & D E F G H | | K &
1 Reactions Variable List 1 streams
2 |Streams BALANCE TOTAL| INPUT: FeS H2504 Air OUTPUT: Salution Offgas INTERMEDIATE:
3 |source ? ? ? Leaching Leaching
4 |pestination Leaching Leaching Leaching ? 2
5 |Temperature  "C 65.00] 75.00 25.00 25.00 25.00 140.00 70.00 70.00
6 |Pressure bar -1.00 3.00 1.00 1.00 1.00 2.00 1.00 1.00
7 |Amount t/h 0.01 84.16 60.00 10.10 14.06 84.17 7174 12.43
8 |Enthalpy kwh -7964.44] -246798.98 -223520.49 -23278.49 0.00| -254763.42 -254922 58 159.16
9 |Valume m3/h -3.68 60.28 50.15 10.13 0.00| 56.60 56.60 0.00|
10 |Exergy kwh -7513.28 33512.47 28640.61 4681.93 189.93] 25999.19 25854.79 144.40|
11 |Heat Capacity  kWh 0.00 0.00 0.00
12 |Gas Phase Nm3/h -1147.34| 10927.08 0.00 0.00 10927.08 9779.74 0.00 9779.74
13 |H20(g) Nm3/h 0.00 0.00 0.00 0.00 0.00|
14 |o2(g) Nm3/h -1147.35| 2294.69) 2294.69 1147.34 0.00 1147.34
15 |N2(g) Nm3/h 0.00| 8632.40 8632.40 8632.40 0.00 8632.40)
16 |Water Phase t/h 7.35| 60.10 50.00 10.10 0.00| 67.45 67.45 0.00| E
17 |H20 t/h 1.84| 50.00 50.00 51.84 51.84 0.00|
18 |H2504 t/h ~10.10| 10.10 10.10 0.00 0.00 0.00|
19 |Fe{+2a) t/h 5.72] 0.00 5.72 572 0.00|
20 |H(+a) t/h 0.00 2.00 0.00 0.00 0.00|
21 [s04(-2a) t/h 9.89| 0.00 9.89 9.89 0.00|
22 |pure Phase t/h 572 10.00 10.00 0.00 0.00) 4.28 428 0.00|
23 [Fes t/h -9.00| 10.00 10.00 1.00 1.00 0.00]
24 s t/h 3.28| 0.00 3.28 3.28 0.00
25 |Amount Phase 1 t/h ~1.63 14.06 0.00 0.00 14.06 12.43 0.00 12.43
26 [Amount Phase 2 t/h 7.35] 60.10 50.00 10.10 0.00) 67.45 67.45 0.00|
27 |Amount Phase 3 t/h 572 10.00 10.00 0.00 0.00) 4.8 428 0.00|
28 |Volume Phase 1 m3/h 0.00 0.00 0.00
29 |valume Phase 2 m3/h -3.68 60.28 50.15 10.13 0.00) 56.60 56.60 0.00|
30 |Volume Phase 3 m3/h 0.00| 0.00 0.00
31 |Density Phase 2 kg/m3 -821.33 2990.85 996.95 996.95 996.95 2169.52 1191.81 977.71
32 |Fes04 Fe(+2a) 0.23] 0.00 0.00 0.00 0.00| 0.23 023 0.00|
33 |H2504 H(+a) 0.00] 0.00 0.00 0.00 0.00| 0.00 0.00 0.00|
34 |H2504 concentrzg/| 1.00) 0.00 0.00 0.00 0.00) 1.00 100 0.00 -
W 4 » M| Unit Balance), Stream Balance ) 1 "' L
Fig. 18. Stream balance sheet of the report file.
@ Flowsheet report — |l =2 ][ x
.c1 g | 5
e = L&
Save  Print Add custom Cells
sheet
| A | B c D E r G H I J -
1
2 |Leaching
_3 Streams Type Total tons Enthalpy e- Fe H N a S
4 |Fes Input 60.00 2880.17 0.00 6.35 5.59 0.00 4441 3.65
] |H2504 Input 10.10 102.95 0.00 0.00 0.21 0.00 6.59 3.30
=] | Air Input 14.07 487.52 0.00 0.00 0.00 10.79 3.28 0.00 | =
7 _SolutiDr‘l Output T1.74 3198.03 0.00 6.35 5.80 0.00 52.63 6.95
8 |Dffgas Output 12.43 436.33 0.00 .00 0.00 10.79 1.64 0.00
| 9 L BALANCE 0.00 -154.72 0.00 .00 0.00 0.00 0.00 0.00
10
11
| 12 |Cooler
| 13 | Streams Type Total tons  Enthalpy H 0
| 14 _Cold Water Input 195.83 10870.06 2191 17391
| 1_5 Hot Water Output 195.83 10870.06 2191 173.91
| 16 BALANCE: 0.00 0.00 0.00 0.00
17 | . o ! 2
|M 4 » M[\ Unit Balance /Stream Balance, 1 ] E

Fig. 19. Unit balance sheet of the report file.
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40.2.2.

Select Unit Models

The user can choose different models for the units. The Select Unit Models window can be
opened from the Tools menu or by right-clicking if the cursor is on top of one of the units,
see Fig. 20. On the left side of the window is the list of units on the flowsheet. In the middle
part the user can select a unit model from the Reactions, Distribution, Particle and Others
sheet (and in the HSC8 update also ‘Import own unit models’). Double-click the unit to
select it and then click OK. Most of the units are dll type but there are still some Excel
Wizards available for the Reactions units. If Excel Wizards are chosen, the user needs to
check the stream names. Information about the units can be found on the right side of the
selector window. Empty Reactions or Distributions units are the same as R and D unit Icons
on the main flowsheet DrawBar, see Fig. 1.

In the HSCS8 update that comes later, there will be instructions on how users can make their
own dll units (Chapter 50). User-made units can be imported using the import sheet.

Bl select unit Models x
Select unit Select model [Double-Click to Select] Model Properties
il Unit Active Model Reactions | Distributions | Partides | Others | Import Cooling Tower Hm3
¥ Unit 1 Model Type Mode : Hydro
Empty Reactions (Hydro) unit DLL Type Code :
:Cooling Tower Nm3 Excel Technalogy :
Cooling Tower tph Excel Sub Technology :
Filter Excel Authors : Tuukka Kotiranta
Thickener gl Excel © Outotec (Finland)
:] Thickener wi-% Excel Besarton =
Thickener gL with OF solids Excel
Select Model | Thickener wt-% with OF solids Excel WIZARD FILE: Cooling Towerxls

WIZARD SHEET:  Cooling Tower Nm3
VERSION:18 October 2012 for HSC Sim 7.1

This calculates needed air feed to the Cooling
Tower

according to the given temperatures and relative
humidity.

NOTE! You need following rows in the variable
list: T, P1g, 02(g), N2(g}, H20(g), P23, H20 and
enthalpy rows. P3 is for solids.

Cancel

Fig. 20. Select Unit Models window.
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40.2.3. Scenario Editor

The Scenario Editor lets you run your process model with different operating parameters
and see how they affect process variables. The calculated results can then be collected in
the charts.

To use the Scenario Editor, first select the processing parameter that you want to regulate
and copy its cell reference from the appropriate cell. Next, open the Scenario Editor and
paste the cell reference in the first SET/GET column (Fig. 21). Then you can add a name
and measurement unit for this variable, but most importantly you should specify whether the
variable will be a regulated (SET) or a calculated variable (GET) (Fig. 22).

%Scenar'so editor =
oy (=Y [ =8 L T ==L
-~ = s L =" =! =
v e - Ly L& s 1= = ==
Run chosen  Runall 2 tions Mew scenaric Clone  Delete selected | Create new SET/GET Delete selected | Create anew Createa
sCenario  sCenarios sheet scemario  scenario sheet data column data column chart tab new chart

[al:} w <Insertreference>
| A B = D [ A T
1 Scenario 1 =
2 | Unit Name
| 3 | Variable Name
4 | Measure Unit
£
6
8

Charts 1 X

SET / GET
Cell Reference

| -
Copy cell reference

Rounds per run| 5
g Paste cell reference

28 -
4 4 » W[\ Scenario 1 1 f

Fig. 21. Add variables to the Scenario Editor by pasting the cell reference of the variable cell.
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2l Scenario editor

HSC 8 — Sim Common Tools
December 10, 2014

- =] X
Ly L b A Ly -
> \ - | =ty =i P
e - o o Lx =] =] B
Run chosen  Run all Mew scenaric Clone  Delete selected | Create new SET/GET  Delete selected | Createanew Creatsa
SCEnario  SCenarios sheet scenario  scenario sheet data column data column chart tab new chart
-
A & D E * L
Scenario 1 Charts 1 X |
| Unit Name Unitl
| Variable Name Ore Feed
M re Unit t/h
il / hoose SET or GET.
| SETLGET: SET You can use "s" or
g
| Cell Reference g’?’r 149 A= shiortouts,

|9

10|

11
12
113

14]

| 15

16|

25
26
27
28

M 4 » M| Scenario 1,

LR BT RS IV S

Rounds per run|

e 3

Fig. 22. Specify the SET/GET value for the variable.

After adding enough variables, specify the parameter values for the SET columns, add
some charts, and finally run the scenario (Fig. 23).

Fig. 23. After specifying the variables, enter the SET variable values, add charts, and run the
scenario.

Copyright © Outotec Oyj 2014


















































































































































































































































































































































































































	j14022a

